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INSTRUCCIONES IMPORTANTES DE SEGURIDAD

CAUTION
DO NOT OPEN

ATTENTION: RISQUE DE CHOC ELECTRIQUE - NE PAS OUVRIR

WARNING: 70 REDUCE THE RISK OF FIRE OR ELECTRIC
SHOCK DO NOT EXPOSE THIS EQUIPMENT TO RAIN OR MOISTURE

Estos simbolos son usados a nivel internacional para advertir de los riesgos
potenciales de los aparatos eléctricos. El rayo dentro de un triangulo
equilatero advierte de la presencia de voltajes peligrosos dentro de esta
unidad. El simbolo de exclamacién indica que es necesario que el usuario
lea el manual de instrucciones incluido.

Estos simbolos advierten también de que dentro de ese aparato no hay
ninguna pieza susceptible de ser reparada por el usuario. No abra esta unidad.
No trate de reparar este aparato por sus propios medios. Dirija cualquier
posible reparacion al servicio técnico oficial. La apertura del chasis de este
aparato por cualquier motivo anular la garantia del fabricante. No permita
que este aparato se humedezca. Si se derrama cualquier liquido sobre esta
unidad, apaguela inmediatamente y llévela al servicio técnico.

Para evitar dafios, desconecte este aparato durante las tormentas eléctricas.

INSTRUCCIONES DE SEGURIDAD

NOTA PARA LOS USUARIOS SI LA UNIDAD ESTA EQUIPADA CON UN CABLE
DE ALIMENTACION.

PRECAUCION: DEBE CONECTAR ESTE APARATO A UNA SALIDA DE CORRIENTE
QUE DISPONGA DE UNA CONEXION A TOMA DE TIERRA.

Los filamentos del cable de alimentacion utilizan el siguiente codigo de
colores:

VERDE y AMARILLO - Toma de fierra
- Adtivo

AZUL- Neutral ~ MARRON

En caso de que el color de los filamentos del cable de alimentacion de este
aparoto puede que no se mnesrondun con las marcas que identifican los
terminales de su enchufe, haga lo siguiente:

« El filamento de color verde y amarillo debe ser conectado al terminal del
enchufe marcado con la letra E, el simbolo de fierra o de color verde,
o verde y amarillo.

« H filamento de color azul debe ser conectado al terminal marcado con
la N o de color negro.

« El filamento de color marron debe ser conectado al terminal marcado
con la L o de color rojo.

Este aparato puede hacer necesario el uso de un cable de alimentacion
y/0 enchufe distintos, dependiendo de la fuente de alimentacion disponible
en su instalacion. SI debe cambiar el enchufe de conexion, pangase en
contacto con un técnico elecricista, que consultard la tabla anferior. £l cable
verde/amarillo debe ser conectado directomente ol chasis de la unidad.

CONDUCTOR No?rgzla_\OR CA/il{eErnativo
L ACTIVO MARRON NEGRO
N NEUTRAL AZUL BLANCO
E TOMATIERRA | VERDE/AMARILLO VERDE

PRECAUCION: Si la conexion a fierra es anuloda, determinadas averias
de esta unidad o del sistema al que esté conectada pueden dar lugar a
un voltaje de linea maximo entre el chasis y la toma de tierra. I tocar
simultineamente el chasis y esa toma de tierra puede dar lugar a dafios
graves 0 incluso la muerfe.

POR SU PROPIA SEGURIDAD
LEA LO SIGUIENTE:
CONSERVE ESTAS INSTRUCCIONES
PRESTE ATENCION A TODOS LOS AVISOS

SIGATODO LO INDICADO EN LAS
INSTRUCCIONES

NO PERMITA (%UE ESTE APARATO QUEDE

EXPUESTO A SALPICADURAS NI DERRAME
NINGUN LI%UIDO o COLO%UE OBJETOS
%UE CONTENGAN LIQUIDOS (COMO
JARRONES) ENCIMA DE EL.

LIMPIE ESTE APARATO SOLO CON UN TRAPO
Y SECO.

NO BLOQUEE NINGUNA DE LAS ABERTURAS
. ALE ESTE APARATO DE
CIONES DEL
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O INSTALE ESTE APARATO CERCA DE

UENTES DE CALOR COMO RADIADORES,
ORNOS, NI OTROS APARATOS

QNCLUYE'NDO AMPLIFICADORES) QUE
RODUZCAN CALOR.

C

OLO ACCESORIOS/COMPLEMENTOS
ADOS POR EL FABRICANTE.

U

FE ESTE APARATO DE LA

TE DURANTE LAS TORMENTAS
UANDO NO LO VAYA A USAR

DURANTE UN PERIODO DE TIEMPO LARGO.

No anule el sistema de seguridad que supone

un enchufe polarizado o con toma de tierra. Un
enchufe polarizado tiene dos bornes de distinto
tamano. Uno con toma de tierra tiene dos bornes
iguales y una tercera lamina para la conexién a
tierra. El borne més ancho o la tercera lamina

se incluyen para su seguridad. En caso de %ue

el enchufe incluido no encaje en su salida de
corriente, haga que un electricista cambie su salida
anticuada.

Coloque el cable de alimentacién de forma que no
quede aplastado ni retorcido, especialmente en la
zona de enchufes, receptaculos o en el punto en el
que salen del aparato.

Use este aparato solo con un tripode, soporte
o bastidor especificado por el fabricante o que
se venda con el propio aparato. Cuando utilice
un bastidor con ruedas, tenga cuidado al mover
el conjunto bastidor/aparato para evitar posibles
dafios en caso de un vuelco.

Consulte cualquier posible reparacion con el
servicio técnico oficial. Este aparato deberd ser
reparado cuando el cable de corriente o el enchufe
hayan resultado dafiados, si se ha derramado algun
liquido o introducido algtn objeto dentro del
aparato, si este aparato ha quedado expuesto a la
lluvia o |la humedad, si no funciona normalmente o
si ha caido al suelo.

INTERRUPTOR DE ENCENDIDO/APAGADO: Si
este aparato dispone de un interruptor Power o de
encendido, ha de saber que dicho interruptor NO
corta la conexion con la corriente eléctrica.

DESCONEXION DE LA CORRIENTE
ELECTRICA: Coloque el enchufe de forma que
siempre pueda acceder facilmente a él. En caso

de instalacion en rack o en un lugar en el que no
pueda acceder al enchufe, instale en el rack o en el
sistema un interruptor de corriente multipolar con
una separacion de contactos de al menos 3 mm en
cada polo.

PARA LAS UNIDADES EQUIPADAS CON
RECEPTACULOS DE FUSIBLES ACCESIBLES
DESDE EL EXTERIOR: Sustituya el fusible
Unicamente por otro de idénticas caracteristicas.

VOLTAJE DE ENTRADA MULTIPLE: Es posible que
este aparato haga necesario el uso de un cable de
allmentacmnc(/o enchufe distintos, delpendlendo
de la fuente de alimentacién disponible en su
instalacion. Conecte este aparato solo a una
fuente de alimentacién del tipo indicado en el
panel trasero. Para reducir el riesgo de incendios o
descargas eléctricas, consulte cualquiera de estos
procesos al servicio técnico oficial.




INSTRUCCIONES IMPORTANTES DE SEGURIDAD

DECLARACION DE CONFORMIDAD

Nombre del fabricante: Lexicon®
Direccion del fabricante: 8760 S. Sandy Parkway
Sandy, Utah 84070, USA

declara que el producto:

Nombre del producto: ~ [<ONIX U22
Nota: El nombre de este producto puede incluir el sufijo EU.

Opciones del producto:  todas (requiere un adaptador de clase Il que cumpla con los requisitos de EN60065,
EN60742 o equivalentes)

cumple con las siguientes especificaciones de producto:
Sequridad: IEC 60065-01 + Amd. 1

EMC: EN 55013 (2001+A1)
EN 55020 (1998)

Informacion complementaria:

El producto citado aquf cumple con los requisitos de la Directiva de bajo voltaje 2006,/95/ECy de lo
Directiva EMC 2004 /108 /EC.

Vicepresidente técnico

8760 S. Sandy Parkway
Sandy, Utah 84070, USA

Fecha: 16 de marzo de 2009

Contfacto en Europa:  Su distribuidor o servicio técnico Lexicon o

Harman Music Group

8760 South Sandy Parkway
Sandy, Utch 84070, USA
Tno: (801) 566-8800
Fax: (801) 566-7005

PRECAUCION RELATIVA AL
COMPATIBILIDAD ENCHUFE DE CORRIENTE EN
ELECTROMAGNETICA REINO UNIDO
.55[59 opurto |<UFHP||9 (0'!,|05d9599°iffifﬂﬁi(§)“§5§e fpmd.U("’ - Es inseguro usar un enchufe de corriente (iue haya
indicadas en lo Decloracion de conformidad. Su funcionamiento ; ;
estd suieo o s dos condicones siguirtes: sido cortado del cable. Deshdgase del cable de
corriente en tal caso. BAJO NINGUNA CIRCUNSTANCIA
®  este aparafo no puede producir interferencias molestas, INTRODUZCA TAL TIPO DE ENCHUFE DANADO O
° Zste aparato debe acemer cualquier interferencia (ORTADO EN UNA SALIDA DE COR.RlENTE DE13
recibido, incluso aquellas que puedan producir un AMP. No uilce el enchufe de corriente si que la tapa
_funcionamiento no deseado. , del fusible esté instalada. Puede conseguir tapas
Evite usar este aparato dentro un campo magnéico potente. de repuesto en su comercio habitual. Los fusiEIes

® use solo cables de inferconexion con blindaje. de repuesto han de ser de 13 amps y DEBEN estar

aprobados por el ASTA con el valor BS1362.

procedimiento de eliminacion de aparatos electrénicos usados que cumple con la legislacion

E A la hora de deshacerse de este aparato, no lo elimine junto con la basura orgénica. Existe un
— actual sobre tratamiento, recuperacion y reciclaje de elementos electroénicos.

Todos los usuarios no profesionales y que sean ciudadanos de uno de los 25 paises miembros de la EU,
Suiza y Noruega, pueden devolver sus aparatos electrénicos usados, sin coste alguno, al comercio en el que
fueron adquiridos (si adquiere alli otro aparato similar) o en determinados puntos limpios designados

En el caso de cualquier otro pais distinto a los anteriores, pongase en contacto con las autoridades locales
para que le informen del método adecuado para deshacerse de este aparato.

El hacer lo anterior le aseguraréd que este aparato sea eliminado siguiendo las normas actuales de
tratamiento, recuperacion y reciclaje de materiales, evitando los posibles efectos negativos para

el medio ambiente y la salud

|-:OMNiX
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Informacién para reparaciones

En el caso de que necesite soporte técnico, péngase en contacto con el Servicio de
atencién al cliente de Lexicon® Professional.

Antes de llamar, tenga a mano todos los datos posibles para describir con precisién
el problema, asi como el nimero de serie de su unidad, que encontrard en una
etiqueta en la parte inferior del I*ONIX U22. Si todavia no ha cumplimentado la
tarjeta de registro de garantia y no nos la ha enviado, aproveche ahora.

Antes de devolver cualquier aparato a fébrica para su reparacién, le recomendamos
que consulte el manual de instrucciones. Asegtrese de que ha seguido correctamente
las instrucciones y pasos indicados en él. Si aun asf sigue sin poder solucionar el
problema, consulte a nuestro departamento de atencién al cliente en el teléfono

(801) 568-7660. Si, finalmente, ha de devolver el aparato a fdbrica para su reparacién,
DEBERA contactar obligatoriamente con el departamento de atencién al cliente

para que el faciliten un Nimero de autorizacién de devolucién. Ningtin aparato serd
aceptado en fébrica sin este nimero. Consulte la informacién de garantia de la pdgina
siguiente, que es aplicable inicamente al primero usuario final. Una vez que haya
expirado el tiempo de validez de la garantia, en caso de que quiera reparar la unidad
en fdbrica le cobraremos el coste de la mano de obra, piezas y embalaje. En todos los
casos, los gastos de envio serdn a costa suya. Lexicon Professional pagard los costes
correspondientes a la devolucién de cualquier aparato que esté bajo garantfa.

Siempre que sea posible, utilice el embalaje original. Indique en el embalaje el
nombre del transportista y este mensaje en rojo: INSTRUMENTO DELICADO,
iMUY FRAGIL! Contrate un seguro de transporte adecuado y envie el paquete
siempre a portes pagados, NO DEBIDOS.

Garantia
Esta garantia solo es aplicable al comprador original y solo en los Estados Unidos de
América.

1. Para validar la garantia, la tarjeta de registro que se adjunta con este aparato
debe ser devuelta por correo (o puede realizar un registro online en la
pdgina web www.lexiconpro.com) en los 30 dias siguientes a la compra del
aparato. La prueba de compra es responsabilidad del comprador.

2. Lexicon Professional garantiza que este aparato, siempre y cuando haya
sido comprado y sea usado en los Estados Unidos de América, estd libre de
defectos en materiales y mano de obra bajo condiciones de uso normales.

3. La responsabilidad de Lexicon Professional de acuerdo a los términos
de esta garantia queda limitada a la reparacién o, de acuerdo a nuestro
criterio, sustitucién de las piezas defectuosas que den muestras de averfa,
suponiendo que el aparato sea devuelto a Lexicon Professional CON UN
NUMERO DE AUTORIZACION DE DEVOLUCION de fébrica, en cuyo
caso todas las piezas y mano de obra quedardn cubiertas por un periodo de
un (1) ano. Para conseguir un Numero de autorizacién de devolucién deberd
ponerse en contacto con Lexicon Professional por teléfono. La empresa no
serd responsable de los posibles danos y perjuicios producidos por el uso de
este aparato en cualquier circuito o instalacién.

4. Lexicon Professional se reserva el derecho a realizar cambios en el disefio o
adiciones o mejoras en este aparato sin por ello estar obligada a realizar esos
mismos cambios o mejoras en los aparatos fabricados anteriormente.

5. Las condiciones anteriores sustituyen a cualquier otra garantia, expresa o implicita,
por lo que Lexicon Professional no asume, ni autoriza a que nadie en su nombre,
asuma ninguna obligacién o responsabilidad relacionada con la venta de este
aparato. Bajo ningin concepto Lexicon Professional o sus distribuidores serdn
responsables del dano emergente o lucro cesante, ni de los posibles retardos en el
cumplimiento de esta garantia debido a causas que estén fuera de nuestro control.
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Introduccién

iEnhorabuena por la compra de su interface de grabacién de sobremesa
Lexicon® I-ONIX U22!

El disefio -ONIX U22 (pendiente de patente) se adapta a la perfeccién
al sitio mds 16gico entre su teclado y monitor. Con todos los controles
de nivel de entrada y de monitor a su alcance, se preguntard por qué a
nadie se le habfa ocurrido nada similar antes.

Con previos de micro dbx® de nuevo disefio de minimo nivel de ruidos
y alto voltaje (60V) en cada canal, el . ONIX U22 estd sobradamente
equipado para ofrecerle grabaciones profesionales. Estos previos
funcionan con una fuente de alimentacién de alto voltaje a 60V para
garantizar su estabilidad y le ofrecen grabaciones de alta calidad a

lo largo de un amplio rango dindmico. Los conversores A/D - D/A le
aseguran un sonido limpio a 24 bits/96 kHz para poder captar hasta el
detalle mds sutil de su actuacidn.

El nombre de Lexicon es sinénimo de “la mejor reverberacién del mundo.”
El plug-in de reverb Pantheon™ II VST/AU dispone de 6 tipos de reverb con
16 pardmetros ajustables y 35 presets de fibrica que van desde efectos

vocales a efectos especiales pasando por sonido directo. Es fcil completar

su mezcla y hacer que su musica suene extraordinariamente con las
excelentes reverbs que han hecho famoso a Lexicon.

Caracteristicas

*  Conexién USB 2.0 a DAW - hasta a 480 Mbps

¢ Velocidades de muestreo de 44.1 a 96 kHz, con resolucién de 24 bits

*  Dos tomas combo analdgicas de 6,3 mm y XLR en el panel trasero para
entradas de micro/linea

* Entrada de instrumento Hi-Z de 6,3 mm en el panel lateral

*  Salidas analégicas TRS de 6,3 mm (principal stereo)

*  Previos de micro de bajo nivel de ruidos y alto voltaje (60V) de dbx®
en todas las entradas analdgicas de micro/linea

e Compatible con Windows® y Mac®

e Alimentacién fantasma de 48 V en cada par de entradas

*  Medicién de senal de entrada mediante 8 LEDs por canal

*  Medicién de sefial de bus stereo y mezcla de sefial

* Conexién de 6,3 mm de alto nivel para auriculares

*  Entrada/salida MIDI

*  Monitorizacién de latencia cero

*  Drivers ASIO de baja latencia

*  Plug-in de reverb Lexicon Pantheon II VST/AU

*  DPaquete de software que incluye el Cubase® LE 4 de Steinberg® y el
Toontrack® EZdrummer® Lite
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Desembalaje de su interface de grabacién de
soiaremeso I-ONIX U22

Dentro de la caja del interface de grabacién de sobremesa I-ONIX U22
encontrard la propia unidad U22 y un DVD con software para Windows
y Macintosh®. Conserve el embalaje por si en algtin momento debe
transportar la unidad. Inspeccione el I-ONIX U22 y su embalaje en busca
de posibles dafios. Si detecta dafios producidos durante el transporte,
comuniqueselo al transportista o a su distribuidor.

®

ELEMENTOS INCLUIDOS:

o U22

* DVD instalador con drivers, este manual, plug-in de reverb Lexicon
Pantheon 11, software de grabacién Cubase LE 4 y ToonTrack® EZ
Drummer Lite para Mac® y Windows®

e (Cable USB

* Tarjeta de garantia Lexicon Professional

¢ Fuente de alimentacién

NOTA: En el DVD de software viene incluido el manual completo del
Cubase LE 4.

Requisitos del sistema

El potente software de grabacién de sonido requiere un ordenador
igualmente potente que disponga del sistema operativo, procesador y
memoria adecuados. La mayoria de los ordenadores actuales ya cumplen
estos requisitos, o pueden actualizarse para ser compatibles con el [FONIX
U22. El disponer de mds memoria RAM de la minima necesaria le permite
realizar mds procesado y mejora el rendimiento.

Windows® Vista y XP

e Sistema multintcleo (recomendado)

* 1 GB RAM (recomendado)

* Pantalla con una resolucién minima de 1024 x 768 pixels
¢ Unidad DVD-ROM

*  Acceso a internet para activacién de la licencia de software

Mac®

*  Procesador Intel®

* 1 GB RAM (recomendado)

*  Sistema operativo OS X 10.4.9 o posterior

* Pantalla con una resolucién minima de 1024 x 768 pixels
* Unidad DVD-ROM

*  Acceso a internet para activacién de la licencia de software

Nota: Para poder visualizar los documentos en formato pdf del DVD se
necesita tener instalado el Adobe Reader.



Panel frontal

PHONES

MIC/LINE/INST MIC/LINE
1 2

|
3

1. LEDS DE NIVEL DE ENTRADA
Le indican el nivel de sefial para cada entrada mostrdndole el margen o
headroom que le queda antes de la saturacién. Sus valores son:

Rojo
Amarillo
Verde
Verde
Verde
Verde
Verde
Verde

Saturacién
-3 dB

-6 dB

-9 dB
-12 dB
-18 dB
-24 dB
-30 dB

2. LEDS DE NIVEL DE SALIDA
Le indican el nivel de sefial para cada salida mostrdndole el margen o
headroom que le queda antes de la saturacién. Sus valores son:

Rojo
Amarillo
Verde
Verde
Verde
Verde
Verde
Verde

Saturacién
-3 dB

-6 dB
-9dB
-12 dB
-18 dB
-24 dB
-30 dB

3. MANDO DE NIVEL PHONES

Le permite ajustar el nivel de salida de auriculares.

4. MANDO DE GANANCIA MIC/LINE/INST 1

Ajusta la ganancia de entrada para la toma Mic/Line 1 o Instrument 1.
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5. LED INSTRUMENT
Se enciende en cuanto introduzca un conector de 6,3 mm en la toma
Instrument del panel lateral derecho.

6. BOTON Y LED STEREO

Este bot6n le permite cambiar entre el modo stereo y el mono para la entrada
Mic/Line 1 (o Instrument 1) y Mic/Line 2. El LED estard encendido en rojo
cuando esté activado el modo stereo.

En el modo stereo (LED Stereo encendido), las sefales de la entrada
Instrument y Mic/Line 1 son enviadas a la salida principal izquierda,
mientras que las sefiales de la entrada Mic/Line 2 se envian a la salida
principal derecha.

En el modo mono (LED Stereo apagado), cada par de sefiales de entrada
son mezcladas y enviadas a las salidas principales izquierda y derecha
como una sefial mono. Cada par incluye la sefal Instrument o Mic/Line

1 y la Mic/Line 2.

Esto no afecta a la sefial que es enviada al ordenador.

7. LED 48V

Se enciende cuando estd activada la alimentacién fantasma para el par

de entradas Mic/Line 1y 2. Puede activar la alimentacién fantasma de
cualquier toma combo de entrada utilizando los botones 48V del panel
trasero. Los micros dindmicos no necesitan electricidad para funcionar,

si bien ésta tampoco los dafa. Sin embargo, la mayorifa de los micros
condensadores si que la requieren. Si no estd seguro de si su micro necesita o
no alimentacién fantasma, consulte la documentacién de su micro o contacte
con su fabricante.

8. MANDO DE GANANCIA MIC/LINE 2

Ajusta el nivel de ganancia de entrada para la toma Mic/Line 2.

9. MANDO OUTPUT LEVEL

Le permite ajustar el nivel de la salida principal izquierda y derecha.

10. MANDO MONITOR MIX

El I-ONIX U22 le permite escuchar directamente y de forma inmediata
sus sefales de entrada analdgicas mientras las graba sin tener que ajustar los
niveles en el programa y antes del retardo producido por los convertidores
digitales y la latencia de grabacién del ordenador. Esta monitorizacién
analdgica de latencia cero es controlada por el mando Monitor Mix, que
puede utilizar para ajustar la mezcla entre las entradas analégicas de directo
y los sonidos procedentes del ordenador via USB (“reproduccién”). Para
escuchar solo las sefales de entrada de la fuente de directo conectada al U22,
gire el mando Mix totalmente hacia la izquierda hasta la posicién Direct.
Para escuchar solo la mezcla procedente del ordenador, gire este mando
totalmente hacia la derecha hasta la posicién Playback. La salida del control
Monitor Mix es rutada a las salidas de linea y de auriculares.

11. LED USB

Se enciende en cuanto sea detectada una conexién USB.
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@ lexicon

wowr = z L
¥WMOd asn Niiamw 1noiaw SLNALNO NIVW IN/OW IN/OW

POWER use MIDI IN MIDI OUT MAIN OUTPUTS
9VAC LEFT

ANcl: @@ {
o /

1. ENTRADA INSTRUMENT

Esta entrada no balanceada acepta un conector de 6,3 mm y admite fuentes
de nivel de instrumento (incluyendo guitarras). Tenga en cuenta que cuando
tenga algo conectado a Instrument, la entrada Mic/Line 1 estard desactivada.

2. TOMA POWER
Conecte aqui solo la fuente de alimentacién PS0913B-xxx incluida
(donde "xxx" indica el voltaje correspondiente).

3. PUERTO USB

Sirve para conectar el U22 a su ordenador. Viene también incluido un cable
standard USB. El U22 es solo compatible con USB 2.0.

4. MIDIINY OUT
Son tomas MIDI de entrada y salida a y de su ordenador. Conecte aqui sus
teclados MIDI, médulos de sonido y controladores externos./

5. MAIN OUTPUTS (SALIDAS PRINCIPALES)

Estas salidas admiten conectores de 6,3 mm TRS balanceados o TS no
balanceados. Puede conectarlas a una mesa de mezclas, etapa de potencia,
monitores de estudio amplificados, grabadoras u otras entradas de nivel de
linea. Para conseguir los mejores resultados, utilice cables balanceados para
estas conexiones.

6. ENTRADAS MIC/LINE 1-2

Estas entradas balanceadas aceptan conectores XLR o de 6,3 mm y admiten
fuentes de nivel de linea y micro. Tenga en cuenta que cuando tenga algo
conectado a la entrada Instrument, la entrada Mic/Line 1 estard desactivada.



7. BOTON DE ALIMENTACION FANTASMA DE 48V - MIC/LINE 1 Y MIC/
LINE 2

Activa la alimentacién fantasma en las entradas Mic/Line 1 y Mic/Line 2.
Cuando esté activada, se iluminard el LED +48V que estd entre los mandos
de ganancia Mic/Line/Inst 1 y 2 del panel frontal. Los micros dindmicos

no necesitan electricidad para funcionar, pero ésta tampoco los dafa. Sin
embargo, la mayorfa de los micros condensadores si que la requieren. Si no
estd seguro de si su micro necesita o no alimentacién fantasma, consulte la
documentacién de su micro o contacte con su fabricante. Este debe estar en
OFF si conecta fuentes de nivel de linea a las entradas Mic In.

8. CONECTOR HEADPHONE

Conecte aqui unos auriculares con una clavija de 6,3 mm. Esta salida recibe
la misma sefial que la enviada a las salidas principales, pero dispone de su
propio control de nivel.



Conexion del *ONIX U22

Micréfonos
Conecte un cable con toma XLR directamente desde el micro a la entrada
Mic/Inst deseada del panel trasero del U22.

Si su micro necesita alimentacién fantasma, compruebe primero que
esté conectado el micro y después, pulse el botén/LED +48V del panel
trasero para el correspondiente par de entradas. Si sus micros no
requieren alimentacién fantasma, es mejor que la desactive.

Nota: Algunos micros pueden resultar dafiados por la alimentacién
fantasma de +48V. Antes de activarla, consulte la documentacién de su
micro.

Fuentes de nivel de linea

Las fuentes de nivel de linea incluyen teclados, cajas de ritmos, reproductores
de CDs, previos de micro y efectos externos. Conecte un cable con toma de
6,3 mm TS (no balanceada) o TRS (balanceada) directamente de la fuente de
nivel de linea a la entrada Mic/Inst deseada del panel trasero del U22. Para
conseguir el mejor nivel de rechazo de ruidos, utilice cables balanceados.

Instrumentos

La entrada Instrument del panel lateral derecho acepta senales de
instrumentos como guitarras eléctricas o bajos. Conecte un cable standard
con toma no balanceada de 6,3 mm TS (cable de instrumento) directamente
del instrumento a la entrada Instrument del panel lateral derecho del U22.
Tenga en cuenta que cuando tenga algo conectado a esta entrada Instrument,
la entrada Mic/Line 1 quedard desactivada.

Ordenador/Workstation de audio digital (DAW)

Conecte el puerto USB de su ordenador al puerto USB del panel trasero del
U22 utilizando un cable USB standard (incluido).

Auriculares

Conecte unos auriculares a la toma Headphone del panel lateral izquierdo.
Esta toma acepta conectores TRS de 6,3 mm. Ajuste el volumen de los
auriculares con el mando de nivel Phones.

Monitores

Utilizando cables con clavijas de 6,3 mm, conecte las tomas L/R Main
Output del panel trasero a las entradas apropiadas de su mezclador, etapa de
potencia o monitores autoamplificados.

Ajuste el volumen de salida con el mando Output Level. Para un

resultado éptimo, utilice cables balanceados.
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Etamoglo de proyecto U22 - Grabacién de una
guitdrra
Para empezar a utilizar el U22 y familiarizarse con ¢él, siga los pasos de este
ejemplo. En €l utilizamos el Cubase® LE 4, pero el U22 también puede
trabajar con muchas otras aplicaciones DAW.

Instalacién de drivers, software de control y Cubase® LE 4
1. Introduzca el DVD en la unidad DVD-ROM. El instalador arrancard

de forma automitica.

Si no sucede asi, puede ejecutarlo manualmente abriendo el

fichero adecuado del DVD:

Mac®: Open Me

Windows®: InstallationMenu.exe

2. Una vez que arranque el instalador, siga las instrucciones que
aparecerdn en pantalla para instalar el software que quiera utilizar.

Nota: Tiene que instalar los drivers I-ONIX U22 para utilizar el U22
con el Cubase® LE 4. También tiene que instalar el Cubase LE 4
para seguir los pasos del ejemplo de proyecto que aparece en las
pdginas siguientes.

También puede descargar los drivers mds recientes desde la
pdgina web www.lexiconpro.com.

Activacién de Cubase LE 4

1. Instale el programa Cubase LE 4.

2. Inicie el Cubase LE 4 y haga clic en Register Now o vaya a la web
www.steinberg.net/en/mysteinberg

3. Cree una cuenta MySteinberg (siga las instrucciones que irdn
apareciendo en pantalla) e identifiquese en MySteinberg.

4. Haga clic en Cubase LE 4 en la seccién de Activation & Reactivation
y después haga clic en More en la seccién Permanent Activation.

5. Teclee su nimero de licencia electrénica de software o Soft-
eLicense (Sel Nr.). Puede encontrar este niimero aqui:
Windows: Inicio > Todos los programas > Syncrosoft > License
Control Center.
Mac: Aplicaciones > License Control Center.

6. Elija Lexicon en el campo Hardware Manufacturer y haga clic en
Request Activation Code.

7. Apunte su cédigo de activacién (Activation code).

8. Vuelva a la pantalla License Control Center (donde encontré su
ndimero eLicense) y haga clic en Wizards > License Download.

9. Haga clic en Next y pegue o introduzca manualmente su cédigo de
activacion. Haga clic después en Enter y finalmente en Start.

10. Una vez que haya descargado la licencia, haga clic en OK y después en
Finish.
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< GUBASE LE
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Monitor PCor Mac

Configuracién de audio y MIDI Windows® (opcional)
Una vez que haya instalado los drivers y el software de control,

puede hacer que Windows los seleccione de forma automdtica como
salidas MIDI y de audio por defecto. Esto significa que sus sonidos
Windows serdn enviados al U22 en lugar de a la tarjeta de sonido de su
ordenador. Debemos comprobar si han sido modificados y devolver los
ajustes a los valores anteriores.

1.

2.

Elija Inicio>Panel de control>Dispositivos de sonido y audio (XP) o
Hardware y sonido (Vista).

Elija la pestafia Audio (XP) o Administracién de dispositivos audio
(Vista).

. En Reproduccién de sonido>Dispositivo por defecto (XP), o

Reproduccién (Vista), compruebe que esté seleccionada su tarjeta
de sonido como unidad por defecto.

. En Grabacién de sonido>Dispositivo por defecto (XP), o Grabacién

(Vista), compruebe que esté seleccionada su tarjeta de sonido como
unidad por defecto.

. En Reproduccién de masica MIDI>Dispositivo por defecto, abra el

mend desplegable y compruebe que esté seleccionada Microsoft GS
Wavetable Synth como unidad por defecto (solo XP).

Proyecto ejemplo - Conexiones

USB Cable

1/4" Instrument Cable

10

|exicon @

Headphone
Output

q D

Headphones



Conexién de la guitarra u22

1. Gire totalmente a izquierda el mando Mic/Line/Inst 1.

©)

lexicon
'MIC/UNE/INST

o C

o
o
|

|
Mando Mic/Line/Inst 1

OUTPUTLEVEL

2. Conecte su guitarra a la entrada Instrument 1 del panel lateral
derecho.

Entrada Instrument 1

11
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u22 Conexién de los auriculares
Gire totalmente a la izquierda el mando Phones 1.

PHONES 1 MIC/LINE/INST MIC/LINE/INST MIC/UNE MIC/UNE MIC/UNE MIC/UNE MIC/UNE MIC/UNE

1 2 3 4 5 é 7 8 )

@_ 3 3 3 H

PHONES 2 ‘STERED pu— swEe0

o o o
. . ©
(@) NTRMENT T TR S
\.

Mando Phones 1

3. Conecte sus auriculares a la toma Phones 1 del panel lateral derecho.

lexicon

Salida Phones 1



-0NIX
Conexidén del ordenador uaa

Conecte el puerto USB de su ordenador al puerto USB del panel trasero
del I-ONIX U22 utilizando un cable USB standard (incluido).

—
GOUBMSELE| | |

? S PC or Mac

Monitor
USB Cable
1
: ® lexicon 9
(A /
ICgLINE MIC{LINE
[ \ \

Escucha de la entrada de guitarra (Directa)

1. Coléquese los auriculares

2. Ajuste el mando de mezcla de monitor a la posicién 12:00. Esto le
permitird escuchar una mezcla en la misma proporcién de las sefales
enviadas al U22 y de las procedentes del Cubase.

3. Toque la guitarra.

4. Gire gradualmente el mando Phones 1 hacia la derecha hasta que
obtenga un nivel de escucha que sea de su agrado.

13
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u22 Configuracién del Cubase® LE 4 para su uso con el
|¢ONIX U22 (Windows®)

1. Asegtirese de que el cable USB incluido esté conectado a su ordenador y al
U22 y compruebe que el U22 esté encendido.

2. Ejecute el Cubase® LE 4 (desde el mend Inicio > Lexicon®).

3. Si aparece el mensaje de aviso mostrado abajo, haga clic en OK.

ASIO Direct Sound Full Duplex Driver E x|

The audio input i not activated. Recording audio is not possible.

Please click on the A510 Control Panel buttan in the System [W5T] or Device
Setup [Nuendo] dialog

Make sure a device name is selected in the Input Ports section and activate
the comesponding check box in the first column.

[V Show This Alert Next Time.

4. Una vez que esté en el Cubase LE 4, vaya a Devices>Device Setup.

MIDI Device Manager
Mixer F3
Plug-in InFarmation

WST Connections F4
VST Performance F1z
Video Fa

Show Panel

Device Setup. ..

5. En Devices, haga clic en VST Audio System vy elija Lexicon I-ONIX
U22 en el mend desplegable de controlador ASIO si no estd ya
seleccionado. Haga clic en Switch para cambiar el driver y después
haga clic sobre OK en el didlogo Device Setup. Ahora ya estard todo
listo para empezar a grabar utilizando su U22 y el Cubase LE 4.

+-im VST Audis System

Nota: En muchos casos podrd mejorar el rendimiento eligiendo un valor
mayor de latencia en el menu desplegable de Rendimiento del sistema
del panel de control ASIO (Devices > Device Setup > Lexicon I-ONIX
U22 > Control Panel > ASIO).

14
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Configuracién del Cubase LE 4 para su uso con el ua2
e ONIX U22 (Mac®)

1. Asegtirese de que el cable USB incluido esté conectado a su ordenador y
al U22 y compruebe que la aplicacién de mezclador esté abierta y que el
U22 esté encendido.

2. Abra el Cubase LE 4 (en la carpeta Applications) y vaya a
Devices>Device Setup como puede ver en la imagen de abajo.

Im Window Help

MIDI Device Manager
Mixer F3
Plug-in Information

VST Connections F4
VST Performance Fi2
Video F8
Show Panel

3. Haga clic en VST Audio System y clija Lexicon I-ONIX U22 como
driver ASIO si es que no estaba ya seleccionado.

4. El Cubase® LE 4 le preguntard ahora si quiere cambiar de driver. Elija
Switch y después OK.

Do you want ta switch the ASI driver?

{

Keep ) ([ Switch)

5. Asegtirese de que el driver esté cargado haciendo clic en Reset.
Después, haga clic en OK.

Solo para usuarios de Mac® OS 10.4.x: Después de seleccionar el
Lexicon X4 como el driver ASIO, tendrd que comprobar que estén
activas las entradas de su dispositivo. Para ello, haga lo siguiente:

1. Elija Device>VST Connections en la barra de mends.

2. Cuando aparezca el panel VST Connections, haga clic en la pestafia Inputs.

3. Puede que el recuadro que hay debajo de la columna Audio Device
indique “Not Connected”. Si ocurre esto, haga clic en este recuadro y
seleccione Lexicon I-ONIX U22 para activar las entradas del U22.

4. Cierre la ventana VST Connections.

Ahora ya estard todo listo para empezar a grabar con el Cubase LE 4, tal
y como le indicamos en la siguiente seccién.

15
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Grabacién de una pista en Cubase® LE 4

Creacién de un nuevo proyecto

1. En Cubase, haga clic en File > New Project. Aparecerd el recuadro de
didlogo New Project.

2. Elija Lexicon I-ONIX U22 Mono In y haga clic en OK.

3. Elija una carpeta de proyecto y haga clic en Choose.

4. Anada una pista mono haciendo clic en Project -> Add Track ->
Audio. Elija la configuracién Mono y haga clic en OK.

5. En la ventana Audio 1, el botén de activacién de grabacién ya
deberfa estar en rojo. Si no es asi, haga clic sobre ¢l para que se encienda.

IE T SIEIEIERES O

F

Make sure the Record
Enable button is lit

6. En la ventana Audio 1, haga clic sobre el botén de monitorizacién de
entrada (O para que no esté encendido.

i Ny ey S, B L

Make 'sU'réIpui
Monitoring button is NOT it




Empiece a grabar

1. Haga clic sobre el botén Record del control de transporte del
Cubase® LE 4.

E 0:00:00.000
K[ > pilo]a] > [e]

‘ Boton Record )

2. Toque la guitarra.
3. Cuando acabe de grabar, pulse el botén Stop.

0:00:00.000
K[« [»DI[o O e

‘ Boton Stop )

Escucha de la grabacién
1. En Cubase, haga clic en el botén Go to Zero.

(e » ool > e

0:00:00.000
|

‘ Go to Zero Button

2. Gire el mando Phones 1 totalmente hacia la izquierda.
3. Coldquese los auriculares.

4. En Cubase, haga clic sobre el botén Play.

0:00:00.000

@[>
L Play Button j

5. En el U22, gire gradualmente el botén Phones 1 hacia la derecha
para conseguir un nivel de escucha que le resulte agradable.

Una vez que afiada una pista a su proyecto Cubase, el campo Input
Routing quedard por defecto en U22 In 1. Sin embargo, si conecta
instrumentos a otras entradas del U22, necesitard modificar el ruteo de
entrada para la pista en la que vaya a grabar. Para ver qué etiquetas de
ruteo de entrada del Cubase LE 4 corresponden a las entradas fisicas
del U22, vea la siguiente tabla.

Etiquetas de ruteo de entrada
Entrada U22 para pistas mono en Cubase
LE 4 (cuando esté utilizando la
plantilla de proyecto Lexicon®
I-ONIX U22 Mono In)

U221In1l

2 U221In2

I-0NiX
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Remezcla Audio

Puede utilizar la funcién de remezcla audio en Cubase® LE 4 para crear
un fichero .wav a partir de su proyecto Cubase, que después podrd grabar
en un CD o reproducirlo utilizando el reproductor multimedia de su
ordenador. Sin embargo, el Cubase LE 4 no le permite remezclar el fichero
en formato mp3; pero, puede utilizar otro programa para convertir un
fichero .wav en otro en formato mp3.

Para remezclar su proyecto, primero tendrd que colocar los

localizadores izquierdo y derecho; una forma de hacerlo es pulsar [Cerl]
+ [A] en el teclado de su ordenador y después [P]. También puede hacer
clic y arrastrar cualquiera de los marcadores hasta la posicién deseada.

Una vez que haya ajustado los localizadores, vaya a File > Export >
Audio mixdown. Haga clic en el botén ‘Choose’ , introduzca el nombre
del fichero en el campo ‘File name?’, elija en el campo ‘Look in’ la
ubicacién en la que quiera que sea grabado el fichero .wav y haga

clic en el botén ‘Save’. Debe grabar el fichero en el disco duro de su
ordenador antes de grabarlo en un CD.

A continuacién, elija Wave File (.wav) en el campo ‘File Format’, ajuste
‘Sample Rate’ a 44.1 kHz, ‘Bit Depth’ a 16 bits y haga clic en Export.

Opciones y funciones en Cubase LE 4

El Cubase LE 4 incluye muchas opciones y funciones avanzadas para grabar,
editar y mezclar audio. Para mds informacién sobre ellas, vea las secciones
‘Puesta en marcha’ y ‘Manual de instrucciones’ que encontrard en el Cubase
LE 4 en Help > Documentation.

Uso del Pantheon Il Reverb en Cubase LE 4

Puede configurar la reverb Pantheon en Cubase LE 4 de dos maneras: como
una insercién en una pista audio o como una insercién en un canal de
efectos.

Para utilizar el Pantheon como una insercién en una pista audio:

1. Asegtirese que el U22 esté encendido y conectado a su ordenador
(el Pantheon II solo funciona cuando es detectado un I*ONIX).

2. Haga clic en la pestafia Inserts para el canal en el que quiera insertar
la reverb Pantheon II.

3. Haga clic en una ranura vacfa y elija Earlier VST Plug-ins > Lexicon
> Pantheon II. Solo escuchard la reverb Pantheon II en la pista audio
en la que haya sido insertada.

Para utilizar el Pantheon II como una insercién en un canal de efectos:

1. Asegurese que el U22 esté encendido y conectado a su ordenador
(el Pantheon II solo funciona cuando es detectado un I* ONIX).

2. Afiada un canal de efectos. Para ello, vaya a Project > Add track > FX
Channel y haga clic en la pestafia Inserts para el canal de efectos.

3. Haga clic en una ranura vacia y elija Earlier VST Plug-ins > Lexicon >
Pantheon II.

4. Haga clic en la pestaiia Sends para las pistas audio a las que quiera

que les afecte la reverb.

. Haga clic en una ranura vacia y ajuste la salida a FX-1 Pantheon II.

6. Haga clic en el botén Power y ajuste el nivel de envio al valor
deseado. Puede enviar al canal FX la sefial de cualquier ndmero de
pistas audio.

N
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Especificaciones técnicas

Entradas de micro:
Impedancia de entrada:
Alimentacién fantasma:
Ganancia mdxima:
E.LN. (a ganancia mdx.):

Nivel mdx. de entrada:
Respuesta de frecuencia:

THD+N:

Entradas de linea:
Impedancia de entrada:
Nivel mdx. de entrada:
Respuesta de frecuencia:

THD+N:

Entrada de instrumento:
Impedancia de entrada:
Nivel mdx. de entrada:
Respuesta de frecuencia:

THD+N:
Salidas de linea:
Nivel:
Impedancia:

Salida de auriculares :

Interface MIDI:
Velocidad de muestreo:

Rango dindmico:

Alimentacién:

XLR hembra; punta 2 activa

3 kQ balanceada

+48 Voltios

+58 dB

-125 dBu @ 58 dB ganancia tipica (150 € fuente)

-129 dBu @ 58 dB ganancia tipica medicién A (150 € fuente)

+21 dBu a ganancia minima

+0/-1dB, 20 Hz - 20 kHz

<0.006%, 20 Hz - 20 kHz (entrada micro a salida principal) 0 dBu nivel entr.
<0.003%, 1 kHz, +5 dBu dBu nivel de entrada

TRS de 6,3 mm balanceadas o no balanceadas

20 kQ balanceada, 13 kQ no balanceada

+32 dBu

+0/-1.5 dB, 20 Hz - 20 kHz (referencia 1 kHz)

<0.004%, 20 Hz - 20 kHz (entrada linea a salida principal) 0 dBu nivel entr.

TS de 6,3 mm no balanceada

1 MQ

+13 dBu

+0/-2 dB, 20 Hz - 20 kHz (entrada de instrumento a salida principal)
<0.004%, 20 Hz - 20 kHz, 0 dBu nivel entrada

TRS de 6,3 mm balanceadas o no balanceadas
>+18 dBu mdximo

32 Q balanceada, 16 Q no balanceada
toma stereo de 6,3 mm 350 mW por canal a 50 Q

Conectores DIN de 5 puntas para entrada MIDI y salida MIDI (sefal 5 voltios)
44.1, 48, 88.2 6 96 kHz (determinada por el programa de ordenador)

A/D (24 bita) 105 dB tipica, medicién A, 20 Hz - 20 kHz
(velocidad de muestreo 44.1 kHz)

D/A (24 bits) 107 dB tipica, medicién A, 20 Hz - 20 kHz
A/D/A (24 bits) 102 dB tipica, medicién A, 20 Hz - 20 kHz

12W9VCA
Adaptadores de corriente disponibles::

EE.UU. y Canadd: 120 V CA, 60 Hz Adaptador: PS0913B - 120

Jap6n: 100 V CA, 50/60 Hz Adaptador: PS0913B - 100
Europa: 230 V CA, 50 Hz Adaptador: PS0913B - 230
Reino Unido: 240V CA, 50 Hz Adaptador: PS0913B - 240
Australia: 240 V CA, 50 Hz Adaptador: PS0913B - 240-AU

Los técnicos de Lexicon® estdn tratando constantemente de mejorar la calidad de nuestros
productos. Por este motivo las especificaciones estdn sujetas a cambios sin previo aviso.
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